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ART AND OTHER STUFF…  IN THIS ISSUE 

This newsletter is created primarily by using 
text columns, so that text automatically 
wraps from one column to the next. Find the 
Columns feature on the Page Layout tab, in 
the Page Setup group. Get tips for setting up 
and using text columns later in this template 

Adding your own content 
The placeholder text for several articles in 
this template provides tips on how to 
customize this newsletter for your needs. 

To replace any placeholder text with your 
own, just select it and start typing. Note that 
if the placeholder text you replace is long, 
such as for this article, it might look like the 
page layout is skewed when you do this but it 
is not. The content that sits lower on the 
page only moves up because less content is 
present when you begin to replace your own 
text. As you type to add your text, content 
will move back into position automatically. 

Placeholders that remain when 
you add text 
The title and subtitle placeholders don’t 
disappear when you add your own text. They 
will look like regular text when printed but 
you can see the blue outline and title of the 
placeholder when you click in it. 

The reason these placeholders remain is that 
they are linked to other placeholders that use 
the same text. So, when you replace the title 
or subtitle placeholder text with your own, it 
automatically populates the corresponding 
placeholders in the headers and on the back 
page mailer.  

Replacing pictures 
To replace a picture in this template with 
your own, select it and then, on the Picture 
Tools Format tab, in the Adjust group, click 
Change Picture. (Or right-click a photo to 
access the Change Picture command.) 

The pictures that you see in sidebars, such as 
In This Issue at right, are formatted as In Line 
With Text so that they sit right in a paragraph 
mark and can be formatted as easily as text. 
The custom paragraph style named Sidebar 
photo applies indent formatting that helps 
align the photos perfectly with the other 
sidebar content. 

Pictures that wrap around some text in 
articles throughout the newsletter use text 
settings and positioning. Get help for 
working with text wrap around pictures later 
in this template.  

 

My Morning May 
Who needs a horse race when you have back to back 
nights with Louisville’s favorite band, and a reissue of 
their breakthrough classic It Still Moves.  (Photos by 
Danny Clinch) 
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Article Title 
To view column breaks, section breaks, and other 
formatting marks, on the Home tab, in the Paragraph 
group, click the pargraph mark icon. 

Page # 

Dear You… 
by Brent Owen 
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The body text throughout the articles in this 
template uses the Normal paragraph style. 
Following are some other styles applied 
throughout the template: 

 Large article titles, such as on the first 
page, use Heading 1 style. 

 Orange headings in the sidebars and 
within articles use Sidebar Heading 
style. 

 Orange section titles in articles use the 
Heading 2 style. 

 Small article titles use Heading 3 style. 

 This style is List Bullet 2. 

This style is List Continue.  

 Text in sidebars uses the Sidebar Text 
style.  

 White headings on orange text in tables 
uses the Heading 4 style. 

 The heading inside contact information 
tables uses Heading 5 style. 

 Contact Info is the name of the gray 
text style inside the small contact 
tables. 

Access all styles used in this template on the 
Home tab, in the Styles group. 

Using styles helps save you time and keep 
your document consistent. To modify a style, 
on the Home tab, in the Styles group, right-
click the name of the style you want to edit 
and then click Modify. All content where the 
style is applied will update automatically. 

Another way to modify a style is to simply 
customize an instance of the style where it’s 
applied in the document. Then, on the Home 
tab, in the Styles group, right-click the style 

name and then click Update [style] to Match 
Selection. 

HEADING 4 STYLE 

Use the small tables provided in some of the 
articles to call out quick reference information 
related to the article, such as contact information 
or event dates. 

HEADING 5 

Contact Info 

 

 

To setup a document for multiple column 
text, on the Page Layout tab, in the Page 
Setup group, click Columns and then click 
the number of columns you need. You can 
also click More Columns to specify column 
widths, the space between columns, or to 
automatically add a vertical line between 
columns. 

To change the number of columns for just 
part of the document (or if you want text to 
wrap to just the top part of the page and a 
new article to start below – as shown on this 
page), insert a section break before the 
position where you want to start the new 
column layout. To do this, on the Page 
Layout tab, in the Page Setup group, click 
Breaks and then click the type of section 
break you need.  

Select a section break 
When changing many types of page layout 
formatting for just part of the document—
such as paper size, margins, or orientation, 
the best section break type to use is a Next 
Page section break because it automatically 
starts the new section on a new page. 
However, when changing the number of 
columns as you might in this newsletter, you 
may prefer to select a Continuous break. The 
continuous section break (used a few times 
throughout this template) starts a new 
section immediately after the preceding one. 
So, for example, you can have a three-
column article followed by a four-column 
article, on the same page. 

  

Using Styles 
by Name Style 

Working with Columns 
by [Article Author] 

This picture caption uses the Caption 2 
paragraph style and is inside a text box 
so that you can move it easily as 
needed to accompany a photo.  
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HEADING 4 

 

Sidebar Setup 
The sidebars in this template use simple, single-row 
tables for the gray-shaded headings and thermometer 
charts shown below for easy alignment. 

 

Add Sidebar Content 
Adding content into a column to create a sidebar is no 
different from adding text. As noted earlier in this 
template, apply the styles provided for headings, 
sidebar text, and even pictures to align them quickly and 
easily. 

FAST FACTS 
 

  

68% 
Learn about these “thermometer charts” in the article at 
right. 

  

42% 
Cras ut blandit diam. Suspendis quis urna semper 
aliquam. 

FOR MORE INFORMATION 

Abico eum, ille et, conventio obruo duis 
ullamcorper ut, neo demoveo. Vel reprobo: 

HEADING 5 
Contact Info 

 

 

 

There are few things in the world that get 
Louisville music fans quite as excited as when 
My Morning Jacket comes home. On May 12 
and 13 they did just that, playing back to 
back sold out shows at Iroquois Ampitheater. 
The band was in fine form (as usual) ripping 
through setlists that featured covers songs 
from last year’s The Waterfall, the soon to be 
reissued It Still Moves, and everything in 
between. 

May 12th Setlist: 

Throwback (When We Were Young) 
Compound Fracture 
It Beats 4 U 
The Dark 
Off the Record 
Spring (Among the Living) 
I Will Sing You Songs 
A New Life 
Lay Low 
What a Wonderful Man 
The Way That He Sings 
Heartbreakin Man 
Tropics (Erase Traces) 
Dondante 
Gideon 
Purple Rain (Prince cover) 

Encore: 
Bermuda Highway 
Wonderful (The Way I Feel) 

Wordless Chorus 
Phone Went West 
Easy Morning Rebel 
Mahgeetah 

Night #1 of the band’s return home they 
focused heavily on their 2005 album Z, with 
nearly a third of the set being culled from 
that record (seven of the album’s ten songs 
were played). Two other noted highlights 
from the first night’s setlist is the inclusion of 
“Throwback 
(when we 
were 
young),” a 
new song 
which will 
presumably 
be featured 
on the 
band’s next 
album; as well as, a set closing tribute to the 
late Prince with a cover of “Purple Rain.” 

May 13th Setlist: 

Throwback (When We Were Young) 
Compound Fracture 
It Beats 4 U 
The Dark 
Off the Record 
Spring (Among the Living) 
I Will Sing You Songs 
A New Life 

My Morning May 
by H. S. Wolfe 

Live 
photos by 
Dave Vann 
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Lay Low 
What a Wonderful Man 
The Way That He Sings 
Heartbreakin Man 
Tropics (Erase Traces) 

Dondante 
Gideon 
Purple Rain (Prince cover) 

Encore: 
Bermuda Highway 
Wonderful (The Way I Feel) 

 

FOR MORE INFORMATION 

Abico eum, ille et, conventio obruo duis 
ullamcorper ut, neo demoveo. Vel reprobo: 

HEADING 5 
Contact Info 
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AROUND TOWN 

 

Lorem Ipsum 
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When it comes to My 
Morning Jacket, the 
line-up is hardly the 
same has it was 
thirteen years ago 
when It Still Moves was originally released. 
Being the band’s third full length album it 
was a time of transition for the Louisville 
rockers.  It their first album with drummer 
Pat Hallahan and their last album with 
founding guitarist Johnny Quaid. 

The album met rave reviews upon its original 
release, with a score of 83 by metacritic.com 
(a website that aggregates reviews of music 
albums, games, movies, TV shows, DVDs, 
and formerly, books. For each product, a 
numerical score from each review is obtained 
and the total is averaged 

Spin Magazine said: “This time, the band lug 
the still-smoking amps from their lightning-
strike live show into the studio and let the 
noise chase the midnite vultures away.” 

 

 

 
 
 
 
 

 

Dolor Sit Amet 
Nulla semper orci id leo adipiscing at pulvinar ante 
porta. In quis orci orci, sed pellentesque dui. Aliquam 

It Still Moves Still Rocks 
by Bill Williams 

My Morning Jacket moves to reissue, remaster, and remix 
their breakthrough album It Still Moves. 
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nec cursus augue. Sed est massa, ullamcorper vitae 
gravida ut. Curabitur pretium eleifend lectus, at faucibus 
lectus 

 

Lorem Ipsum 
Nulla semper orci id leo adipiscing at pulvinar ante 
porta. In quis orci orci, sed pellentesque dui. Aliquam 
nec cursus augue. Sed est massa, ullamcorper vitae 
gravida ut. Curabitur pretium eleifend lectus, at faucibus 
lectus 

  

Title Lorem Ipsum Dolor 
by [Article Author] 
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Lorem ipsum dolor sit amet, consectetur 
adipiscing elit. Nullam sed luctus tellus. 
Pellentesque in dolor sapien, vitae dictum 
massa. Aenean vitae lorem dui. Morbi 
tempus lacinia nisi, vel scelerisque nibh 
facilisis id. Integer urna tortor, ullamcorper 
aliquet viverra non, mollis sed dolor.  

Donec nunc velit, pretium eu pellentesque 
eget, mollis vel arcu. 

Suspendisse vel purus nec erat pellentesque 
commodo. Aliquam tempus aliquam mauris 
vel dapibus. Nullam at metus erat, in 
convallis massa. Aliquam erat volutpat. 
Praesent ultrices odio in elit fringilla id 
rutrum mi mattis. 

Duis purus eros, aliquam eu cursus tincidunt, 
feugiat vitae magna. Etiam sodales 
consequat nibh, eget rhoncus metus 
convallis et. Morbi rutrum mollis facilisis. 
Aenean faucibus  

Morbi tempus lacinia nisi, vel scelerisque 
nibh facilisis id. Integer urna tortor, 
ullamcorper aliquet viverra non, mollis sed 
dolor. Etiam sodales consequat nibh, eget 
rhoncus metus convallis et. 

Phasellus dignissim nulla at diam fermentum 
in sollicitudin sem condimentum. 
Pellentesque condimentum diam et sem 
rhoncus semper sed at libero. Aenean 
condimentum, lorem vel faucibus 
pellentesque, quam nunc lacinia augue, vel 
sagittis dolor ipsum vitae velit. Ut feugiat 
odio ac dolor iaculis consequat. Praesent sed 
lacus ante. Nullam pretium commodo libero, 
at congue sapien dignissim a. Cum sociis 
natoque penatibus et magnis dis parturient 
montes, nascetur ridiculus mus. In hac 
habitasse platea dictumst. Vestibulum ante 
ipsum primis in faucibus orci luctus et ultrices 
posuere cubilia Curae; Ut fermentum sem 
non metus faucibus blandit. Sed placerat 
bibendum fermentum. 

 

 

 

 

Louisville 
Effing 
Rocks! 
Art and 

other stuff… 

[Street Address] 
[City, ST  ZIP Code] 

  

Title Lorem Ipsum 
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[Addressee] 
[Street Address] 
[City, ST  ZIP Code] 

 


